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Guide to ONPHA’s Budgeting Tool for

Non-Profits with some Market-Rent Units

1. Overview

This Excel-based1 Budgeting Tool is for non-profit housing providers funded under
Section 103 or Section 110 of the Social Housing Reform Act (SHRA). Sec. 103 sets out the
“regular” subsidy model. Sec. 110 allows for changes to the regular formula where
“economic conditions” prevent the proper application of the regular model. Typically,
people refer to Sec. 110 as applying to parts of the Province with a “flat or declining”
rental market. For your 2006 budget year, you do not need to know whether you are in
a flat or declining market area.

If less than five per cent of your non profit’s units are market-rent, you should use the
tool and guide for providers covered by Sec. 106 of the Act (100% RGI).  This includes
alternative housing providers.

You can use this tool to give the board a high-level view of your non-profit’s budgeted
revenues and expenses for the year and also to ask your Service Manager for the
subsidy to which you are entitled under the Act.

Note: this tool does not teach you how to budget. It is only a way of presenting the
budget and subsidy request in a format your board and Service Manager can use.

The Budgeting Tool has seven sheets:

1. Information that identifies your corporation

2. The indexed market rents and the rents you actually plan to charge for all the
unit types in your non-profit.

3. The corporation’s budgeted operating costs, followed by a preliminary break-
even estimate.

4. The corporation’s budgeted non-shelter revenue and expenses.

5. A summary of other revenues and costs along with the cost indices that apply
to your portfolio.

6. The actual subsidy request to the Service Manager.

1 You should be able to use the tool with Excel ’97 or more recent versions of the
software. It also works on Excel X and 2004 for Mac.
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7. A series of summaries of the calculations behind the results.

You can print the sheets on 8.5 x11 paper if you would like.

The tool is designed for providers with ten or fewer projects funded under Sec. 103 or
110 of the SHRA (the new funding model). If your portfolio has more than ten such
projects, or if you find you need help at any point along the way, you can contact
ONPHA’s Management Help Hotline at 1-800-297-6660 or 416-927-9144.

To complete the tool, you will need some information from your current-year budget,
your last year’s actual expenses, your benchmarks and the indices published by MMAH
that apply to you.

Here is a quick review of things to keep in mind as you use this Tool:

If we refer to a key or Excel command, it will be in bold. For example Tab means press
the “Tab” key and Enter means press the “Enter” key. Click means press the mouse
button to close a dialogue box or to make a cell become active so that you can enter data
there.

If you are copying information from one cell to another, you can use the Copy and
Paste commands in the Edit menu. Never Cut and Paste. This will cause errors in the
calculation. If you enter data in the wrong cell, you can Copy and Paste it into the
proper cell, then Delete it from the wrong cell. Or you can just Delete from the wrong
cell then re-enter it in the correct cell.

Generally, you only need to enter a number in a cell (although sometimes, you will
enter “Y” or “N” to answer a question, or text to give a name or description). When you
are entering numbers, do not enter any letters, commas, $, or other symbols.  Entering
any symbols in cells where the Tool expects only numerals will cause errors in the
calculations.

2. Getting Started

To begin, follow these steps:

i. Download the Budgeting Tool onto your computer’s hard drive.
ii. Open the Tool either through your operating system or by using the

“Open” command in Excel and navigating to the place on your hard drive
where you saved the Tool.

iii. Save the file immediately by clicking on the “File>Save As” button on
your toolbar and giving the file a new name. The original tool you
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downloaded is locked, so you cannot save it with project data
without giving the file a new name. We have locked the tool so that
you will always work from a copy and keep the original unchanged. This
will be useful if your working copy becomes corrupted or damaged. If
you are working on a budget year after the benchmark year, either print
your previous year’s sheets or give your new file a different name from
the old one. This is because you need to carry forward some information
from one year to the next. Remember to save the re-named tool
frequently as you work on it.

3. Entering Data

Corporation Worksheet

Click on the tab named “Corporation” at the bottom of your screen. This will activate
the worksheet where you will enter certain information that will identify your non-
profit for the Service Manager.

1. Click on, or Tab to, the cell beside “Year End” and then enter the end date of the
fiscal year you are budgeting for. Use the mm/dd/yy (month/day/year) format.
Make sure you remember the “/” between numbers.

2. Pressing the Tab key once will take the cursor to the cell where you enter the
name of your corporation (beside “Provider Name”).

3. Next, Click on or Tab to the cell immediately below. This is for the ID number of
your non-profit, if the service manager uses this system. Enter the number that
the service manager gave you. If you didn’t receive one, leave the cell blank.

4. Click on the cell beside “103” and enter either Y or N, depending on whether
you have any units covered by Section 103 of the Act, the “regular” funding
model. Then click on the cell beside “110” and enter a Y or N, depending on
whether or not you have projects in a part of the Province that is a so-called “flat
or declining” rental market.  (For your 2006 budget year, you will not know
whether you are in a flat or declining market area because the Ministry of
Municipal Affairs and Housing has postponed making this decision.)

5. Click on or Tab to the cell beside “Mailing Address”. Use this and the following
four lines to enter your address.

6. The next section is for you to enter the name of the non-profit’s contact person
(you or the person designated to communicate with the service manager), that
person’s position, phone number, fax number and e-mail address. Tab between
cells to move through this section. The cells for phone and fax number have
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already been formatted in the (xxx) xxx-xxxx format, so you just need to
enter the 10 digits of each number.

7. Tab to the next cell to enter your service manager. Leave the remaining four cells
blank for the service manager’s use.

Rents and Indices  Shelter Worksheet

Click on the tab named “Rents” at the bottom of your screen to activate the next
worksheet.

1. Click on the cell beside “Rent Guideline”. Enter “1” plus the current guideline
published by the Ministry of Municipal Affairs and housing (MMAH). For
example, if the rent guideline is 2.1%, enter “1.021”.

Each year, MMAH will update the guideline in August, so use the most current
one that exists.  You can find this information on the MMAH website,
www.mah.gov.on.ca .

2. Click on the cell beside “Project Name”. Enter a name you use to identify one of
your projects. It doesn’t have to be the legal name, just an identifier that makes
sense to you. If you have more than one project, tab along the row to enter a
name for the second project, then click below the first section to find the cell for
the name of project three, and click or tab to get to project four and so on.

3. When you have finished entering the names, go back to the first project and click
on the cell beside “Municipality”. Two small arrows will appear to the right of
the cell. Click on the arrows to produce an alphabetical list of municipalities.
Keeping the mouse button pressed down, move the cursor till you highlight your
municipality. Release the mouse button and the name of your municipality will
appear in the cell.

4. If your corporation is a private or municipal non-profit, go to the cell where you
will enter the “Rent District Code.” The proper code for your project is listed in
MMAH’s Social Housing Branch (SHB) notifications on Unit Rent Factors in
Release 04-05 at http://www.mah.gov.on.ca/userfiles/HTML/nts_1_21915_1.html.
(Remember that the apparent spaces are really “underscore” marks.) It should be
the same code as you have entered on previous budget forms. Repeat these two
steps for all your projects. If your corporation is neither a PNP nor MNP, you can
ignore this step.

5. Now move (by pressing the Tab or Enter key or by using the point-and-click
method) to the section for entering data about the number of units you have and
the planned rents.
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There is room for you to list all the units for each project. The Ministry’s
benchmarking recognizes three kinds of units; apartments, townhouses
(including stacked and row), and Semi/single/other houses, so this budget tool
uses the same categories. There is space in each unit-type section for you to enter
information about units that do not match the sizes we have already listed.

The process for each unit type is essentially the same, so we will use
“apartments” as the example.
a) If you have bachelor units, Point and Click with the mouse, or use the

Tab and Enter keys until you highlight the cell under the label “Total
Units in Project” in the row with “Bach” on the left. (If you have no
bachelor units, move to the first row that names any apartment size you
do have in the project.) Enter the total number of units of the relevant
bedroom category in the project.

NOTE: in all of the cells, except those mentioned in step “h”, you must
enter numbers only. Do not enter letters, commas, $ or other symbols.

b) If you have market-rent bachelor units in this project, enter their current
actual number. If you have no market-rent bachelor units, you may either
enter the numeral “0” or leave the cell blank.

c) Tab to the next cell, “Previous Indexed Market Rent.” If the year you are
budgeting is the benchmark year, enter the benchmark number. If the
budget year is later than the benchmark year, enter number from the year
you are currently in.  eg. In your 2007 fiscal year, your Previous Indexed
Market Rents will be your 2006 benchmarked rents.  In your 2008 fiscal
year, your Previous Indexed Market Rents will be the 2007 benchmarked
rents multiplied by the 2007 Rent Index from MMAH.

d) Tab to the next cell, with the heading “Rent Index (from MMAH)”. Enter
the number. If you are budgeting for the benchmark year itself, enter 1.
(Remember: in subsequent years, if your non-profit is covered by Sec. 110,
it is possible that this index number will be less than 1.) As of September
2005, we don’t know how these indices will be expressed.  If they are a
percentage, similar to the Rent Guidelines, follow this example.  If the
index is 2%, enter “1.02” (1+2/100).  If the index is -2%, enter “.98” (1-
2/100).

e) Tab to the next cell “Projected Turnover” and enter the number of market
units of this type you think will turn over. (Obviously, if you have no



Guide to ONPHA’s Budget Spreadsheet 2005 6

market units of this type, you would enter zero.) The treatment of
the benchmark year is different from subsequent years. In the
benchmark year, enter zero. For subsequent years, make your best guess,
since the formula that determines the subsidy you will receive during the
year uses this number. If the rent index from MMAH is higher than the
rent guideline, try not to under-estimate the turnover. This is because the
subsidy determination depends in part on the turnover rate of your
market units. If your turnover estimate turns out to be low, the
reconciliation of your financial statements for the year will show you as
being entitled to less subsidy than you might have thought. This will
affect your cash flow in future years when the service manager adjusts for
any subsidy overpayment. On the other hand, if you overestimate your
market turnover, then your subsidy flow in the budget year may be less
than the amount you’re entitled to.

f) The next column is a calculated amount, so when you Tab your cursor
will move to the next column “New Market Rent”. Enter the average
monthly market rent you plan to charge for a bachelor unit in this project.
Ideally, this number should be no lower than the number in the cell
immediately to the left. If the numbers in the “New Market Rent” column
are consistently lower than the numbers in the “Indexed Market Rent”
column, you run the risk of having a financial shortfall during the year in
part because your rent subsidy for RGI units will be based on the lower
number.

g) Move to the next apartment unit size and repeat the above process.

h) The apartments section of the project sheet has five lines at the end for
“Other” sizes of units. If you have a unit size that you cannot enter in the
lines above, click to the right of the first cell that says “Other” and enter a
description of the unit size or characteristic that led you not to include it
above. Then proceed along the line as in the steps above. Repeat this
process as necessary.

i) When you have finished entering the information for “apartments” in that
project, repeat the process as necessary for the other unit types.

NOTE: Do not try to enter any totals or subtotals. The number of units is
calculated automatically, and the other columns do not require totals.
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6. When you have finished entering the unit rental income for the first
project, Tab to or click on the cell beside “Project RGI rental income”.
Enter the total amount of income you expect to receive from your RGI residents.
Do not include any subsidy in this amount. Note: if you have only one project,
then this cell is where you will enter all your anticipated RGI rent for the year.
Even if you have more than one project, you may enter your entire RGI income
budget for the entire portfolio in this cell if this is easier for you. Otherwise, enter
the appropriate project amount in proper cell in each project. The cumulative
total for RGI income for your entire portfolio is shown directly under the cell for
the project RGI income in the first project.

7. Next, Tab to or click on the cell beside “Project Vacancy Loss”. Enter the
anticipated vacancy loss from your market units in that project for the year.
Again, if you have only one project, then this cell will equal your portfolio
vacancy loss. Even if you have more than one project, you may choose to enter
your entire vacancy number in this cell, or you can enter an amount in the
corresponding cell for every project. Again, the cumulative total for the portfolio
will be shown in the cell directly below the one for vacancy lost in the first
project.

8. Repeat steps 3 to 7 for each of the remaining projects in your portfolio that is
covered by Sec. 103 or 110 of the Act.

Operating Costs:  Shelter Worksheet

Click on the next tab named “Operating Costs” at the bottom of your screen to activate
the next worksheet.

This sheet has three columns. The first column is for the actual amounts from the last
fiscal year you have completed, as set out in your audited financial statements. The
second column is for the amounts from the budget for the fiscal year you are now in.
The last column is for the budget for the new fiscal year you will be entering next. The
year end for the fiscal year you are now budgeting for will be shown if you entered it on
the “Corporation” worksheet.

Note: you do not need to enter data in the first two columns (apart from the amount of
your capital reserve contribution in the current year). This is because all the calculations
in the rest of the tool only relate to the upcoming year. However, recording information
in the first two columns will help the reader view the year-to-year change.

1. Enter maintenance salaries, wages and benefits for the entire portfolio for each of
the three years on line 105, then press Tab.
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2. Move through the various Maintenance sub-items, entering budget items
as appropriate. When you get to the end, Line 120 will contain the total of
line 106 to 114.

3. Follow the same procedure for Utilities, Administration and Other.  If this is
your benchmark year, use “1” as the index.  Your total operating costs will show
up on line 155.

4. The next line (number 185) is for your capital reserve contribution. The SHRA
says your capital reserve contribution should be indexed. MMAH will publish an
index number annually. After you enter the index number and the current-year
contribution, the tool will automatically calculate the budget-year number.

5. If you transfer money out of operations to any other fund, enter the amount on
line 195.  For example, you may be targeting revenue from gifts and donations to
a special use for which you have set up a fund.  If you do not have a gift and
donation fund, or net non-shelter revenue, you will not likely have such a fund.
Note: This fund must be for a permitted shelter use.

Line 196 will show a total of your budgeted operating costs and contributions to funds.

For now, ignore the bottom section of this page, entitled “Initial Break-even Estimate”.
If you have a non-shelter component, go to the “Non-Shelter” worksheet.  If you do not
have a Non-Shelter component, go to the “Other Costs, Revenues & Indices” worksheet.

Non-Shelter Revenue and Expenses Worksheet

Click on the tab named “Non-Shelter”.  This page has three columns. The first is for
revenue and costs associated with any care component, the second for any commercial
component you have, and the third is the total of the first two. Values in the entire third
column as well as rows 310, 316, 330 and 340 are computed automatically. If you have
non-shelter revenue and expenses, enter the information in the appropriate spaces.

When you are finished, or if you have no non-shelter component, go to the “Other
Costs, Revenues & Indices” worksheet.

Other Costs, Revenues and Indices Worksheet

Click on the tab named “Other Costs, Revenues & Indices”, at the bottom of your
screen, to activate the next worksheet. This sheet has two sections. All providers using
this tool should enter data on the first section. Only Sec. 110 providers need to enter
data on the second.

1. You will note that the first column “Project Name” has already been filled in
with data you entered from the “Rents” sheet. Click on the cell below
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“Mortgage P&I” and enter the amount you are budgeting for this
expense. You can either break down your total mortgage expense by
project, or put the complete portfolio expense in the first cell, whichever is
easier for you. In any case, once you are finished, the correct total should
show in the cell on line marked “Total”.

2. Click on the cell below “Property Taxes” and repeat the process, either
entering your total anticipated expense, either by project or listing the total
portfolio expense in the first cell. The total again will be shown below.

3. Tab to or click on the first cell below “Parking & Laundry”. Again, if you
have more than one project, you have the option of entering the entire
amount in the first cell or of breaking down the data by project. Click or press
Return to move down the column to enter the appropriate numbers in the
correct cells. The portfolio total will be show below, on line 221.

4. Tab to or click on line 222 and enter investment income for the portfolio. This
does not include any return on your capital reserves, which is tracked within
the fund itself. Then Tab to or click on line 223 to enter other non-rental
income; for example, room rental or roof antenna income. You should enter
the line 222 and 223 items separately from parking and laundry because the
funding model treats them differently. Line 225 has the sum of line 221, 222
and 223.

5. Tab to or click on line 232 and enter gifts, donation, etc. Your net non-shelter
revenue (if any), as calculated on line 340 of the previous sheet, will
automatically appear on line 233. Your total of Non-Rental, Non Shelter and
Other Revenue will also be calculated automatically, on line 235.

6. The next three lines use information from the benchmarks you received from
MMAH or your service manager. (Even in years after the benchmark year,
you still enter the benchmark numbers here.) Tab to or click on line 241 and
enter the affordable mortgage payment. Tab to or click on line 242 and enter
your Total Benchmark Operating Costs. Tab to or click on line 243 and enter
your Total Benchmark Revenues (Benchmark Market Rents + Benchmark
Parking and Laundry Revenue less Benchmark Vacancy Loss).  You need
these numbers to help calculate your mandatory payment. Remember,
regardless of which year you are budgeting for, you must enter the original
benchmark numbers in these three lines.

7. Line 244 repeats the MMAH rent guideline you entered on the “Rents” sheet,
so you shouldn’t enter anything here. Line 245 contains the calculation of
your indexed market rents, so you shouldn’t enter anything here either. Tab
to or click on line 246, “Indexed Market Revenue from Previous Year”. If you
are budgeting for your benchmark year, enter in this cell the same number
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you entered on line 243. If you are budgeting for a subsequent year,
you will need to bring forward the number on line 523 of the budget
tool. If you printed the former year’s tool, you can look it up on the paper
copy. If you have saved the former year’s tool separately from the current
year’s tool, you can go to the former file, select the number on cell 523, copy
it, then return to the current tool, line 427 and select Edit>Paste
Special>Values to insert the proper number.

8. If your portfolio is entirely covered by Sec. 103 of the Act, you have finished
entering data on this sheet. If you have any projects covered by Sec. 110, you
should move the second section of the sheet “Cost Indices”. Tab to or click
on the cell on line 247 under Cost Indices if you have any projects with
electrically heated units. Enter the index number from MMAH. If this is the
benchmark year, enter 1. Repeat this for line 248 if you have any projects not
heated electrically. Again, enter 1 if the budget year is your benchmark year.

9. Tab to or click on the first cell on column called, “Indexed Operating Cost:
Current Year.” If you have only one project, or if all your projects are heated
the same way (either electrically or non-electrically) you can enter your entire
number in the first cell if you prefer. If you have a number of projects with
different heating types, you must break down your total costs by project.  If
you have a project that has both electrically heated units and units heated
with gas or oil, choose the “Project with Electric Heat” option.  If your tenants
pay for their own heat, base your choice on the heating source(s) for common
areas.

Again, if the budget year is the benchmark year, use the benchmark operating
cost number you received from your service manager. (You probably
received a single benchmark number for the entire portfolio, so you will have
to distribute the total across your various projects.)

10. Tab to or click on the next column and enter Y or N for each project,
depending on whether or not it is electrically heated.

11. The rest of the cells should be calculated automatically. Do not attempt to
enter any data on these rows. You have now finished entering data on this
sheet.

NOTE: Remember to Save your work.



Guide to ONPHA’s Budget Spreadsheet 2005 11

4. Looking at the Results

At the bottom of the “Operating Cost” page, there is a section called “Initial Break-even
estimate”. All of the cells should have been filled in automatically, except for line 251
(Additional Subsidy). If you have not asked for – or if the service manager has not
agreed to grant – any extra subsidy beyond the amount you’re entitled to under the
subsidy formula, leave this cell blank for now and look at line 299 (Net Income).

If line 299 shows a net income, you are probably finished entering all the data you need
to. If line 299 shows an operating deficit for the year, you should re-examine your cost
budget higher up the page to see if you can manage any reductions. Alternatively, you
can re-examine your revenue budget. If you still are projecting a deficit, and this is your
first year of operations after you have received your benchmarks, try to negotiate a
subsidy phase-in amount to cushion the impact of the benchmarks. If the service
manager agrees to the phase-in subsidy, enter the amount for the year on line 506 of the
tab entitled “Subsidy phase-in”.

If that year you are not entitled to a subsidy phase-in, or if you still have a deficit
showing on line 299 after entering the phase-in amount on line 506, you may want to
consider asking the service manager for additional subsidy. Be cautious about doing
this, though, since Sec. 111 of the Act allows the service manager to impose additional
conditions on you in return for giving extra subsidy. Enter the amount you will be
requesting on line 251.

Remember, both the subsidy phase-in on line 506 and the additional subsidy on line 251
are negotiated between you and your service manager, but they are separate concepts.
The phase-in is to help you move from your former operating regime to the new
benchmarking one in a manageable way. You can ask the Ministry to arbitrate if you
believe this money is essential to your provider’s viability as you make the transition
but the service manager does not agree. The additional subsidy is granted solely at the
service manager’s discretion, and the service manager is entitled to impose conditions
on you in return for giving these funds.

5. The Subsidy Request Page

The tab marked “Subsidy” shows your subsidy request to the service manager using
the formula set out in Sec. 103 and 110 of the Act. It has four sections on two pages.

The first section is your calculation of mortgage subsidy, which is the difference
between your actual mortgage payments and the affordable mortgage payment, as
calculated through the benchmarking process. Note: if the service manager is allowing
you a phase-in period to reach your benchmarking numbers, as discussed above, you
are entitled to some additional subsidy to help smooth the way. Enter the transitional
subsidy you have negotiated with your Service Manager on line 503.
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The second section is the calculation of your RGI subsidy, which is the difference
between the lower of your indexed market rents for RGI units and the actual
market rents for those units and the amount the RGI tenants are actually expected to
pay.

Section three is the mandatory payment. If you are a Sec. 103 provider, only the top half
of this section will show any data. The mandatory-payment calculation will yield a
result on line 530. It cannot be a negative number if you are a section 103 provider.

If your non-profit is covered by Sec. 110 of the Act, the last part of this page will also
contain calculated data. Your mandatory payment is the lesser of lines 530 and 537. A
negative number is actually an increase to your subsidy.

The second page of the subsidy request form is the rollup of the previous three
components of the subsidy formula, with the addition of line 543, your property taxes.
If you have decided to ask for additional subsidy to help you break even, the amount
you entered on line 251 will show up on line 547.

Note: The actual subsidy formula set out in the Act allows for a reduction in subsidy
equal to half of your operating surplus for the year. However, since you won’t know
until the end of your year whether or not you have a surplus, there is no point in
allowing for it in your subsidy request. If you do happen to have a surplus, you will
report this on your Annual Information Return (AIR) at the end of the fiscal year.

6. Submitting Your Subsidy Request

If you like, you can print all the sheets from tabs 1, 2, 5 and 6 of the file (see the next
section of the Guide) and mail or fax them to your service manager. You do not need to
send tabs 3 or 4, since the subsidy formula does not depend on your actual operating
costs, or tab 7, since it is only for your own information.

If you plan on emailing the file directly, you may not want to let the service manager
see tab 3 or 4. You can lock them from view as follows:

a) When you have finished entering all your data and are ready to send in the
file, save it, then click on the tab called “Operating Costs”.

b) Go to “Format” in the menu bar, then select “Sheet>Hide”. The Operating
Costs page will disappear.

c) Go to “Tools” in the menu bar, then select “Protection>Protect
Workbook…”. Enter a password at the prompt, and then repeat when
prompted again. Now the sheet cannot be read by anyone who doesn’t have
the password. (Don’t forget it yourself, or you’ll have locked the page
forever.)

d) Repeat the process for the tab called “Non-Shelter”.
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e) You can now close the file and email it to the service manager, who
will be able to read tabs 1, 2, 5, 6 and 7, but not 3 or 4.

f) When you want to re-open tab 3 or 4, go to “Tools” then
“Protection>Unprotect Workbook…”. Next go to “Format>Sheet>Unhide”.
Highlight the name of the hidden sheet you want to reveal. Press OK.

7. Printing the sheets

You can print each of the tabs on 8.5 x11 paper. Tabs 1, 3, 4 and 5 will fit on one page
each. Tab 6 fits on two pages. Tabs 2 and 7 will fit two projects to a page, so the number
of pages will depend on the number of projects. If you have only one or two projects,
when you select the “Print” option in Excel, be sure to select to print only 1 page out of
5. If you have three or four projects, select to print pages 1 and 2 out of 5, and so on.

8. Further Help and Advice

We have technical support available to you as you work with this Tool. If you need help
or advice, call the ONPHA Management Help Hotline at 416-927-9144 or on our toll-
free line at 1-800-297-6660.


